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  הקדמה .1

 המעשית במעבדת במהל� עבודת� , התלמיד�תואוללוות  להנחות א הימטרת מדרי� זה

  ובטר� נדקדקבטר� נרד לפרטי� .1מדעי המחשב במסגרת לימודי היחידה יסודות , המחשבי�

  אותנו כמכנה משות� שפה אחידה שתשמשננסה ליצור, ונקפיד במיקומו של כל תו ופסיק

  . המעשיתבעבודתנו

מהי , )...למרות שעל פניו הוא מהווה חלק בלתי נפרד מחיינו( עלינו להבי� מהו המחשב ,ראשית

 .ומה פרוש להרי" תוכניתכנית ות) לקמפל(שי� להדר למה הכוונה כאשר אנו נדר ,כנית מחשבות

  . של ספר הלימוד וכא� נתייחס אליה� על קצה המזלג1מושגי� אלה מוצגי� בפרק 

לעבד אותו ולהציג ,  הוא מערכת אלקטרונית היכולה לקרוא נתוני� ממקור קלט כלשהוהמחשב

  .כפלט את תוצאת העיבוד

 מילה היא הוראה כאשר, ות לביצוע משימה נתונה היא סדרה של הוראות מדויקמחשבוכנית ת

  ".מבי�"או רצ� מילי� שהמחשב 

ופ� טקסטואלי וכוללת היא כתובה בא. שפה עילית קרויבמה שבדר� כלל כנית מחשב כתובה ות

ביצוע פעולות , הגדרות משתני� בזיכרו�,  לקריאת נתוני� מהקלטהוראות מובנות יחסית

 וניתנת לשמירה )editor (עור�כנית נכתבת בעזרת ות. '� לפלט וכו נתוניהצגת, חשבוניות ולוגיות

  . כקוב" במחשב

הוראות . )machine language( לשפת מכונה יש לתרגמה ,כנית מחשבות" יבי�" שהמחשב כדי

היא קשה מאוד להבנה לבני לכ� שפת מכונה  של אפסי� ואחדות ורצפי� למעשה �שפת מכונה הב

 .1100 1010 0000 1110: שרית בתוכנית הכתובה בשפת מכונההנה שורה אפ, למשל. אד�

 מהדרה .הידור כנית בשפת מכונה נקראוכנית משפה עילית לתותהלי� בו מתורגמת תה

)(compiler אותה  מתכתובה בשפה עילית ומתרגשכנית ו תתהקורא ,כנית מחשבו ת ג�הוא

  .אותה להרי� שנית� יהיה כדילשפת מכונה 

Java כגו�,להבדיל משפות עיליות אחרות, אבל ,יתהיא שפה עיל  C או C++,  תוכניות הכתובות

אינה שהיא עדיי� , bytecodeלשפת ביניי� הנקראת קוד� כל  המהדר  מומרות על ידיJavaבשפת 

 מפרשה. )interpretation( פרשנותישנו שלב נוס� שהוא שלב ה, כלומר. שפת מכונה

)interpreter( של Javaתפקיד כפולתמחשב בעלכנית ו הוא ת  :�במהל� פעולתו . הרצהו תרגו

�לוקח המפרש חלקי� קטני� מהbytecode , מתרג� אות� לשפה מכונה ומיד מרי" אות�.  

  ? ולהריצהכנית מחשבו שנוכל לכתוב תכדימה� בעצ� הפעולות הנדרשות מאתנו 

 כאשר לכל תוכנית , תוכניותשלוש יש צור� בJavaכנית בסביבה מבוססת ולכתוב ולהרי" תכדי 

  :תפקיד שונה

  . עור�– )Notepad משלל(מעבד תמלילי�  .1

 Compiler –מהדר  .2

  Interpreter –מפרש  .3
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 : הפעילויות הנדרשות להגיע לשלב ההרצהרצ� בצורת תרשי� את מציגה 1 תמונה

  בשפתכניתובשלב הראשו� נכתוב ת

Java ע� סיומת בקוב" הנשמרת 

].java[ . של  הקודמכיל אתקוב" זה 

  .התוכנית

 את רי"כדי שאפשר יהיה לה

התוכנית יש לתרג� אותה לשפה 

שפה זו נקראת . אותה המחשב מבי�

 המחשב יכול להרי". "שפת מכונה"

  .שפת מכונהב תוכנית

�  :התהלי� מתבצע בשני שלבי

�ה . 1Compiler של שפת Java 

�מתרג� את התוכנית  ל

bytecodeהדומה לשפת מכונה .  

�ה . 2Interpreterאת ה � מתרג�

bytecode לשפת מכונה וישירות 

    .מרי" את התוכנית

 1תמונה 

  
DrJavaסביבת פיתוח עבור שפת א הי ,Java ללא מכוונת לסייע לתלמידי� בתכנו� הפיתוח ש

�הרעיו� המרכזי שעמד בפני המפתחי� הוא לספק  . להתמודד ע� סביבות פיתוח מורכבותצור

 כלי פיתוח בעל שהיא , מצד אחדוח ופשוט לתפעולנ,  ממשק משתמש קלבעלתסביבת עבודה 

יכולות ומאפייני� מתקדמי� למשתמש ג�  ת מספקDrJava. מצד שני, צמה ע� מגוו� יכולותוע

 המאפשר ,)Interaction Pane (שיח�דו על חלו� הות עיקר הפונקציות המתקדמות מבוסס.המנוסה

  . 5.6ואותו נכיר בסעי� , לבצע חישובי ביטויי�

�אל סביבת העבודה אנחנו מגיעי� לאחר ?  DrJava  סביבת לנותמה בעצ� מאפשר, א� כ

ו רוצי� להשלי� את ואנ, Javaויישמנו אותו כתוכנית בשפת , שפיתחנו פתרו� לבעיה אלגוריתמית

  .תהלי� הפתרו� בכ� שנרי" את התוכנית על דוגמאות קלט שונות ונבח� את הפלט

כאשר אנו מדברי� . מחשבהכנית ות קוד המקור של ת לנו לכתוב אתמאפשר DrJava סביבת •

 כתיבת שכוללות את, על כתיבת תוכנית בסביבת הפיתוח כוונתנו למכלול פעולות עריכת הקוד

  .'מחיקת שורות וכו, הוספה, הזזה, ביצוע שינויי�יכולת , הקוד עצמו

ב ומאגד תחת קורת גג " בארהRice שפותח באוניברסיטת DrJava אנחנו נעבוד ע� כלי שנקרא

#ת הכתובות בו לתוכניכסביבת פיתוחמשמש  DrJava , כלומר,הללואחת את כל הפעולות 

java .ות�א) נקמפל(נהדר , בעזרתו נכתוב ונערו� את התכניות ,� .ולבסו& ג� נרי
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 של  ונוחההקלבמסגרת חלו� כתיבה המאפשר עריכה , קוד המקור ייכתב בחלו� עריכה ראשי

   .כניתוקוד הת

  .את הקוד ולתק� שגיאות הידור במידת הצור�) לקמפל(לאחר הכתיבה נית� יהיה להדר  •

 syntax(תחביר הוראה שאינה תואמת את כללי השגיאת הידור מתרחשת כאשר אנו כותבי� 

ת הידור בולטת בתצוגתה ובפרטי� הנלווי� שגיא DrJavaבסביבת  .הנכו� של השפה) בלעז

    . לסייע לנו באיתור מקור הבעיהכדי

כנית ולוודא ונית� להרי" את הת, כנית שעברה בהצלחה את שלב ההידורוכאשר בידינו ת •

רוש והתרגו� ימאחורי הקלעי� מתבצע ג� תהלי� הפ (שהפלט המתקבל הוא אכ� הפלט הנדרש

  .)כפי שהוזכר לעיל

  .בצע ל מאפשרת לנוDrJavaסביבת , ...)והרבה יותר (אלהואת כל 

  ? המעבדהומה תפקידו של מדרי�

  .להדרי� ולסייע, לכוו�:  פשוטתפקידו של מדרי� זה

בעזרתה לכתוב תוכניות תוכלו לאפשר לכ� הלומדי� להבי� ולהכיר את סביבת הפיתוח וכיצד 

 ולדעת להתמודד ע� בעיות , לקבל תוצאותכדי צ�להריו �נכונותאת לוודא , Java בשפת מחשב

  .ביבה זושיכולות לצו" בס
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 סביבת העבודה .2

 תפריט ראשי )א( :2 בתמונהמוצג ומודגש ש כפי , רכיבי� מרכזיי�כמהסביבת העבודה מורכבת מ

, בחלקו התחתו� של העור� .חלו� רשימת הקבצי�) ד( חלו� עריכת קוד המקור )ג( סרגל כלי�  )ב(

 )Interaction Pane( שיח� דו חלו� ה)ה( : שמאפשרות לפתוח חלונות נוספי�ישנ� מספר לשוניות

  .(Console) חלו� קונסול) ז( )Compiler Output – קומפילציה(הידור חלו� פלט ) ו(

  

  

 2 תמונה

  

לאחר שלחצנו על הלשונית המתאימה או שהפעלנו ) 3תמונה  ראו(ילר יכ� נראה חלו� פלט הקומפ

 �  )Compilation – הקומפילציה(ההידור את תהלי

  

  3תמונה 

כפי שנראה , בהתא� לבחירה בפעולות שונות, נפתחי� חלונות נוספי� תו� כדי עבודה, לעיתי�

�  .בהמש

  חלון
  רשימת 
  הקבצים

  שיח-דוחלון ה

  חלון עריכה ראשי
  )קוד מקור(

  תפריט ראשי

  סרגל כלים

  ילריחלון פלט קומפ
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  כנית הראשונה שליוהת .3

 שנוכל לתרגל את כדי בכתיבת תוכנית פשוטה וקלה ,מדי�ו להנחות אתכ� הל היאמטרת פרק זה

הידרנו ,  לאחר ששמרנו את קוד המקור בקוב",קבלת פלט התוכניתל שלבי הכתיבה השוני� עד

  .כניתווהרצנו את הת

...). זו המסורתא� , צר לי על חוסר המקוריות (HelloWorldAppכנית שנכתוב נקראת והת

   .Hello World את המילי�כנית זו כפלט על המס� ותתציג , בעקבות הרצתה

  

 ):משמאל לימי�, לפי הסדר(פריטי� הבאי� על ידי בחירה בת :DrJava הפעילו את .1

Start → Java Environment → DrJava  

 בתיקיה של DrJavaשל ) Icon(על הצלמית ) Double Click (לחצו לחיצה כפולהאו פשוט 

C:\Yesodot\) להפעלתו �) כברירת מחדל( נפתח עבורנו בעקבות ההפעלה ).או על קיצור הדר

  .  עדיי� בזיכרו� המחשבקוב" זה אינו שמור. untitled בשלב זה הואקוב" חדש ששמו 

  

 בסרגל הכלי� New להקיש על כפתור ,האחת: לפתיחת קוב" חדש ישנ� שתי אפשרויות .2

בתמונה ראינו ש מתקבל המס� :File, File → New בתפריט New היאופצלבחור ב והשנייה

  .2. מס

  

 האופציב ובחרלש� כ� ). ת הקודפעולה זו ניתנת לביצוע ג� לאחר כתיב( את הקוב" שמרו .3

Save בתפריט File , כלומרFile → Save ) או כפתורSaveבסרגל הכלי� .( � נקבל את המס

 :הבא

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 4 תמונה
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. ובחרו בתיקיה בה את� מעונייני� לשמור אותו, HelloWorldApp ,הקלידו את ש� הקוב"

. )4ראו תמונה  (]java.[יהיה קוב" ע� סיומת  Saveישמר לאחר לחיצה על כפתור יהקוב" ש

   .כדאי לוודא כי לקוב" שנשמר אכ� יש את הסיומת הדרושה

 :) על סימני פיסוק ואותיות גדולות וקטנותודיהקפ( את התוכנית הבאה ודיהקל .4

  
  
  
  
  
 

 

  
  
  
  
  
  
  
  

 כש� המחלקה צרי� להיותש� הקוב" . HelloWorldApp.javaשמרו את הקוב" תחת הש�  .5

או ,  בסרגל הכלי�Save ברירת המחדל שתוצע לכ� כאשר תלחצו על כפתור זוו ,וב" מכילשהק

 . File → Save: בחרו בתפריט אתת

  : את התוכנית)קמפלו(הדרו  .6

א� לא נעשתה טעות .  Tools → Compile Current Document : בחרובשורת התפריט

  תיקיה בה נשמר הקוב"באותה ,HelloWordApp.class בש�  קוב" חדשרייווצהקלדה 

HelloWorldApp.java) ו�תתקבל ) Compiler Output(בחלו� פלט המהדר . ) הדברודאו שכ

  .Last compilation completed successfully.:ההודעה

, דרשו לשמור אותו לפני ביצוע ההידורית, )5סעי� (לא שמרת� את הקוב" בשלב הקוד� א� 

  .תבצע רק על קוד שמור בקוב" ההידור יכול לה.)5 תמונה ראו(

  

  

  

  

  

  

  

  5 תמונה

/* 

Output: the sentence "Hello World!"  

*/ 

 

class HelloWorldApp  

{ 

  public static void main (String[] args)  

{ 

 

// Display message "Hello World!" 

        System.out.println ("Hello World!"); 

  } 

} 
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, כלומר. Always save before compilingנית� למנוע הישנות הודעה זו א� נבחר את האפשרות 

לפני ) על פי ש� הקוב" שנית� לפני כ�(אנו מבקשי� לשמור באופ� אוטומטי את הגרסה העדכנית 

  .כל פעולת הידור

  :כניתו את התהריצו .7

  . Tools → Run Document's Main Method   בחרוטבשורת התפרי

�דוויופיע ג� בחלו� ה) Console( בחלו� הקונסול צג יו,Hello Word המילי�, כניתופלט הת

 .6בתמונה  כפי שנית� לראות שיח

  6 תמונה

תוב במקו�  נכ:...) מדוע לא כדאיאולי כדי לראות (...כעת ננסה להתחכ� .8

System.out.printlnה את �רצ System.out.prnln  את ) לקמפל(וננסה להדר

 .בדקו מה תהא תגובת המהדר. כניתוהת

  

 תוכנית  את תהלי� עלנדגי�, כנית מחשבו של ת וההרצהשהבנו את תהלי� הכתיבהלאחר  ,כעת

, מוצגת כא�כנית כפי שהיא ו את התודיהקל . שכל תפקידה לקלוט מספר של� מהמשתמשנוספת

   .אותה יצו והרוהדר, GetNumber.Javaאותה תחת הש� רו שמ

 

  
  
  
  
  

  
  
  
  
  
  
  

/* 

Input: an integer number, typed in by the user 

Output: The given number 

*/ 

 

class GetNumber 

{ 

    public static void main (String args[]) 

    { 

 // Read in an Integer number 

      int input_num = In.readInt ("Insert an Integer Number:"); 

 

 // Print the number typed by the user 

      System.out.println(input_num); 

    } 

} 
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בסביבת .  והיכ� מופיעה בקשת הקלט, להקליד את המספר השל�כ� בו עלילחלו� הקלט ♥♥♥♥ מושי

DrJava ו, בשני חלונות נפרדי� הדבר מתבצע�  : התפקיד השונה של כל חלו� היאהסיבה לכ

 בחלו� מוצגת) Insert an Integer Number( או ההנחיה על טיב הקלט המבוקש, לקלטהבקשה 

את הקלט . שיח ע� המשתמש� החלו� בו מתבצע הדווזהמשו� ש )Interaction Pane( שיח�דוה

  . הקלטהזנת לצור� מופיע מעצמו אשר, DrJavaעצמו יש להקליד בחלו� הקלט הסטנדרטי של 

  

  

  

  

�כנית בובסיסית של כתיבת תהתחושה את השקיבלנו לאחר Javaוהבנו את הת  � המתבצע כדיהלי

 ונדו� בסביבת את בסיס הידע וההבנה שלנו, בהמשכו של מדרי� זה,  נרחיב ונעמיק,כניתו תלהרי"

  . השוני�העבודה על מרכיביה

לאחר הכנסת הקלט בחלו� .  התוכנית עוצרת בהגיעה לשורת הקלט וממתינה לקלט:♥♥♥♥שימו 

  !ניתכורק אז תמשי� ריצת התו  Done או על כפתור Enterהקלט יש ללחו" על מקש 
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 חלונות סביבת העבודה .4

 חלונות כמהסביבת העבודה תצוגת  כוללתקלה וידידותית ,  לאפשר סביבת עבודה נוחהכדי

  .נוח וקלול תפעכול� יחד מספקי� ו ,מרכזיי�

�החלו� המרכזי הוא הText Editor ,חלו� עריכה ראשי) Definitions Pane( . חלו� זה מאפשר

�את כתיבת הקוד בJava ,צביעה אוטומטית של מילי� שונות בקוד �לצור� בהירות וקריאות  ,תו

  .מתאימה)  - Indentationאינדנטציה( שורות והזחה  אוטומטי שלמספור, הקוד

בחירת . בכל רגעמציג את רשימת הקבצי� הפתוחי� , רשימת הקבצי� חלו� ,ליהחלו� השמא

א� , קוב" חדש שנפתח.  בחלו� העריכה הראשי של הקוב"תציג את תוכנובחלו� זה קוב" מסוי� 

  .untitledכותרת ה בחלו� זה תחת ע יופי,עדיי� לא נשמר

תציג את החלו� כל אחת מה� ל לחיצה עו,  התחתו� של סביבת העבודה ישנ� שלוש לשוניותהבחלק

החלו� השני מציג את פלט תהלי� , )Interaction Pane (שיח�דוחלו� אחד הוא חלו� ה . לההמתאי�

   :)Console( הוא חלו� הקונסול שלישיוהחלו� ה) Compiler Output(הקומפילציה , ההידור

� הסביבתשל ) הטובי� יותר (ההוא אחד מיתרונותי )Interaction Pane (שיח#דוחלו� ה 

DrJava.  חלו� ה. המתחיל ותרומתו רבה ג� למשתמש המנוסההלומד מקל על עבודת חלו� זה

  .ש לכתוב מעטפת מורכבתומבלי לדר, מאפשר בצורה זריזה לנסות קטעי קוד

  או במשתני� מסוימי�מסוי�  חישובי� מספריי� או השמת ער� במשתנהנית� לבצע, למשל

 נית� לבצע פעולות מורכבות יותר בהתבסס על באופ� דומה.  אלהוביצוע חישוב ע� משתני�

פעולות נוספות יפורטו בתת פרק .  מראה חישוב פשוט שנוכל לבצע בחלו�7תמונה  .מבני� פנימיי�

5.6.  

 7 תמונה

 הפלט של תהלי� ההידור והשגיאות מציג את )Compiler Output(הקומפילציה , חלו� ההידור

   ).קומפילציה( ההידור  או הודעה על הצלחת)היו כאלוא�  (אותרוש

בנוס� להצגה בחלו� ( הפלט וצגוג� מכנית וקלט התמתבצע ומוצג  )Console(חלו� הקונסול ב

  ).שיח�דוה

כאשר אנחנו , למשל. תו המתבצעותפעולל בהתא� ,חלונות נוספי� מתווספי� תו� כדי עבודה

מתווספת לשונית , Find / Replaceעולת  פ,כניתומבצעי� פעולת חיפוש או החלפה של טקסט בת

  .   ) התמצאות וחיפוש,5.7 סעי� ראו  (נוספת שמספקת אפשרויות נוספות של חיפוש
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 הפעלה בסיסית .5

 ,בכלל DrJavaעולות הבסיסיות הנדרשות לעבודה בסביבת העבודה של פרק זה ד� בכל הפ

ליצור , DrJavaד להפעיל את  כיצנלמד .בפרט, DrJava  העבודה של קבצי� בסביבתעבודה ע�בו

 נלמד בנוס� .קוב" וכמוב� להרי" תוכנית שפיתחנו) לקמפל(להדר , לפתוח קוב" קיי�, קוב" חדש

�כנית בוכיצד להגדיר את הסביבה וכיצד להרי" תDebug Mode ,ניפוי שגיאות ריצה �  .לצור

  ?DrJava כיצד להפעיל את . 5.1

על ) Double Click(רש הוא ללחו" לחיצה כפולה נדשכל .  פשוטה וקלהא היDrJavaהפעלת 

נית� לשנות  ".J"אות כה צורתש) Icon( הצלמית על ידיהמיוצגת , DrJavaתוכנית ההפעלה של 

� ללמשל, התוכניתש� את drjava.exe )לתוכנית זו )ש� שבו אנו נשתמשה �  .ולהגדיר קיצור דר

   ויצירת קבציםת פתיח.5.2

 קוב" חדש . בסרגל הכלי�New על כפתור צו או לחFileתפריט מ New ו ליצור קוב" חדש בחרכדי

 או Fileתפריט מ Openו  לפתיחת קוב" קיי� בחר. ונית� להתחיל להקליד את תוכנוכ�נוצר עבור

לו� ש� התיקייה מופיע בכותרת ח. חלו� בחירת קוב"ייפתח .  בסרגל הכלי�Open על כפתור צולח

  .)8  תמונהראו( מתאימהלהגיע לקוב" הנדרש בתיקייה הכדי  ותונית� לנווט בי� התיקיהבחירה 

  8 . מסתמונה

drjava-stable-20060127-2145.exe
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ש� הקוב" יצור� לרשימת הקבצי� שנמצאת בחלו� , ברגע שיצרנו קוב" חדש או פתחנו קוב" קיי�

 מתו� כאשר נבחר קוב" אחר. שימת הקבצי� וטקסט הקוב" יופיע בחלו� העריכה הראשיר

   ." עכשווי ותוכנו יוצג בחלו� העריכה הראשייסומ� הקוב" כקוב, רשימת הקבצי�

   שמירת קבצים.5.3

א� הקוב" .  בסרגל הכלי�Save על כפתור צו או לחFileתפריט מ Save ו לשמור קוב" בחרכדי

 היכ� ושאלית,  הקוב" מעול� לא נשמרא� .רסת הקוב" השמורתעודכ� ג,  בעבר נשמרכבר

. ש� התיקייה הנוכחית יוצג בכותרתהו, שיח�דו תיבת כ� תוצג בפני. לשמור קוב" זהכ�ברצונ

  .רצוי לשמור את הקוב" במקומו הכדי רצויהלנווט לתיקייה הנית� , מתיקייה זו

 ...)שמירה בש�( Save Asנית� לשמור את הקוב" תחת ש� שונה על ידי בחירת האפשרות 

בתפריט  Save All  בחירת האפשרותעל ידי או לשמור את כל הקבצי� הפתוחי� Fileבתפריט 

File )9 תמונה ורא(.  

  9תמונה 

  של קובץ) קומפילציה(הידור . 5.4

  .י� בנקודת זמ� מסוימת קוב" בודד או את כל הקבצי� הפתוח)לקמפל( להדר נית� 

  Compile Current Documentיש לבחור את האופציה  , )פעילה(להדר את הקוב" הנוכחי כדי 

כפתור ההדר את כל הקבצי� הפתוחי� יש ללחו" על  לכדי). Shift+F5קיצור דר�  (Toolsבתפריט 

Compile All האופציהלבחור את  או Compile All Documents  בתפריטTools ) �קיצור דר

F5(. קוב" העבודה חייב להיות שמור על הדיסק )תאופציי Save בתפריט Files ( כולל כל השינויי�
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תתקבל הודעת השגיאה ,  הקוב" אינו שמורא� .ובטר� נית� יהיה להדר, האחרוני� שבוצעו

  .10בתמונה המופיעה 

  

  10תמונה 

 �כאשר ). Compiler Output( בחלו� פלט המהדר יוהידור מסתיי� מוצגות תוצאותהכאשר תהלי

מתקבלת ההודעה הבאה בחלו� פלט )  מסתיי� ללא שגיאות הידור,כלומר(תהלי� ההידור מצליח 

  ). בחלקה התחתו�,11 תמונה ראו(. .Last compilation completed successfully: ההידור

  

  

  

  11תמונה 

 שגיאות נמצאותהלי� ההידור בא� .  רשימת השגיאותמוצגת ,כאשר תהלי� ההידור נכשל

)Errors( וג� אזהרות )Warnings( ,כאשר רשימת , ה השנייי שתי הרשימות אחת אחרתוצגומ

ואז , " באמצעות העכבר על שורת שגיאה בחלו� פלט ההידורוחלל נוכל.  ראשונההופיעמהשגיאות 

 לנווט כדי) מעלה ומטה(נית� להשתמש בחיצי� . השורה השגויה בקוד המקורתסומ� בצבע צהוב 

בחלו� במקביל יודגשו ודגש בצהוב השגיאה בחלו� פלט ההידור ותבכל שלב . בי� הודעות השגיאה

 כדי השורות שעלינו לבדוקאלה .  להודעת השגיאהרמושגהשורות , ג� כ� בצהוב, העריכה הראשי

  .)12ראו תמונה  ( ולתקנה את מקור השגיאהזהותל

 הגדרת הצבע המתאי� בקוב" על ידי ,מצהוב לצבע אחרצבע הסימו� נית� לשנות את  :הערה

  .7.2 כפי שמוסבר בסעי�, )הקונפיגורציה(ההגדרות 

  

 אפשרויות ההידור השונות
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  12תמונה 

  כניתוהרצת ת. 5.5

ונוצר , לאחר שעברה בהצלחה את תהלי� ההידוררק  Javaכנית ותנית� להרי"  DrJavaבסביבת 

   .ה המתאימהיבתיקי [class.]קוב" ע� סיומת 

 )F2קיצור דר� ( Run Document's Main Method היש לבחור באופצי, כניתוהת להרי" את כדי

 הראשית פעולהאת הפעולה זו תטע� את הקוב" הנוכחי ותרי" . )13 תמונה ראו( Toolsבתפריט 

  .2Fולכ� מומל" להשתמש במקש , אי� כפתור בסרגל הכלי� שמייצג פעולה זו .שלו

 

  

  13תמונה 

קוב" ערכנו שינויי� ב א� ,כלומר. כניתוהתתור" הגרסה התקינה האחרונה של  תמיד :♥♥♥♥שימו 

 קוב") קוד�בעקבות הידור (וקיי� , הידורהא� שינויי� אלה לא עברו בהצלחה את תהלי� הנוכחי 

  . הודעה על חוסר תאימותוצג ותהיש�קוב" היור" , ]class.[ ע� סיומת יש� בש� זה

 בסעי�הנושא יורחב  (נדרש המשתמש להזי� קלט לתוכניתכנית והרצת תבמהל� , במקרי� רבי�

כנית ונראה שהת) חישוב שטח מלב� (14כנית שמופיעה בתמונה וא� נבח� את הת, למשל). 5.7
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ההנחיות  .)במקרה זה גובה ורוחב מלב�, איזה קלט עליו להקליד(ות למשתמש מדפיסה הנחי

  :בעוד שאת הקלט עצמו יש להקליד בחלו� הקלט הסטנדרטי, שיח�דו בחלו� המוצגות

  

  14תמונה 

  Abortנוכל להשתמש בכפתור, ג� בזמ� המתנתה לקלט, א� נרצה להפסיק את הרצת התוכנית

  :)'א15 תמונה ראו(

  

  'א15תמונה 

 אי� צור� .שיח יראה אוס� של הודעות�וחלו� הדו, הריצההלחיצה על כפתור זה מפסיקה את 

 המסגרת המלבנית ראו (� נובעות מהפסקה פתאומית של תהלי� ההרצהרק להבי� שה, להתרגש

   ) .'ב15תמונה ב תהמקווקוו
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  'ב15תמונה 

  )Interaction Pane(שיח -חלון הדו. 5.6

� הוראות וביטויי� ו המאפשר למשתמש להקליד ולערשיח�דו חלו� העה אתמצי DrJava סביבת

�בJava. ש, למשתמש המתחילה�  צורת עבודה שימושית ונוחה מאוד זו� להכיר  לש� כ�לא צרי

חלו� זה ,  מההיבט הלימודי. וה� למשתמש המנוסה,Java בשפת כניתו כתיבת ת� שלכלליהאת כל 

 להכיר את תחביר השפה  צרי��אי. יחסיתתוח בצורה קלה שפת הפיהוראות  בנסותמאפשר להת

   . את יכולות השפהללמוד ולחוש באופ� מעשי כדיבמלואו 

 כולל חישוב של , חוקיתJava תומ� בביצוע של כל הוראת שיח� דוחלו� ה ?אז כיצד נשתמש

 להשי�, ה מלא בעת כתיבת תוכניתעושי�כפי שהיינו ,  משתני�הצהיר בו על לנוכל, לכ�. ביטויי�

שלא נכתב כל הוראה תוצאת הביצוע של . לביצוע בשפהאחרות ולכתוב הוראות ,  ערכי�בה�

שנכתב בסופה הסימ� בעוד שהוראה , שיח� הדותוצג בחלו� ) ';'( פסיק� נקודהבסופה הסימ�

, שיח�דו המוצגת בחלו� הת ביצוע כל תוצא. לא תוצגת ביצועהא� תוצא, תתבצע, פסיק� נקודה

�וג� בחלו� ה(ע ירוק  בצבתוצגמConsole .( בצבע אדו� תוצגומהודעות שגיאה של המערכת 

   .)ונית� לשנות�צבעי� אלה ה� צבעי ברירת המחדל (

  :שיח� דושימוש בחלו� הלהנה כמה דוגמאות 
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 )16תמונה ראו ( שיח�דובחלו� ה ,HelloWorldApp, כנית הדוגמה הראשונהוכתיבת ת .1

 . שורה אחת בלבדכהמצרי

  

  61נה תמו

  

שיח �דו ה חלו� שמאפשרת להבי� את יכולות,שונהמעט בעלת אופי ו דוגמה מורכבת יותר .2

�הוראות בשלוש  סדרה של נכתבה . 17תמונה במוצגת java )שמסתיימות ) חישוב שטח מלב�ל

. א� ההוראה מתבצעת, התצוגה אינה משתנה, עבור שתי ההוראות הראשונה. פסיק� בנקודה

על א� התוצאה תוצג רק כאשר נבקש זאת באופ� מפורש , צע החישובבפעולה השלישית מתב

 : הקשת ש� המשתנהידי

  

  71תמונה 

בעקבות  . מהמשתמש קלטשיח תוכנית המבקשת� דו בחלו� הנכתבת ובה,  דוגמה נוספתראהנ .3

  Standard Input: כותרתוש, DrJava של הקלט הסטנדרטי יופיע חלו� ביצוע פעולת הקלט

 .שיח�ההנחיה הנלווית לפעולת הקלט מופיעה בחלו� הדו  .)18ראו תמונה (

  

  81תמונה 

תתקבל הודעת השגיאה בחלו� ,  במקו� מספר של�A האות למשל את,  נקיש קלט שגויא�

  .)Console – ג� בחלו� הקונסולו. (שיח�דוה
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  שיח-דו פעולות שכיחות בחלון ה5.6.1

.  יותרקצר ויעיל,  לפשוטשיח�דולו� ה� חישנ� לא מעט פעולות שעושות את תהלי� העבודה ע

  הימניכפתורה על הקשה ל ידי עאו Toolsמתפריט :  באחת משתי הצורותתופעלומפעולות אלה 

  .19 תמונהבהמוצג  התפריט הקשה הגורמת להופעת, שיח�דועכבר בחלו� השל ה

  

  

  91תמונה 

ה� בעלות אותה משמעות  )Copy, Cut, Paste(גזירה והדבקה ,  של העתקה השכיחותהפעולות

  . אחרותכבכל יישו� חלונ

  Reset Interactions:שיח#דו ה)ניקוי(איפוס  ••••

  או פעולותפעולהמנקה משתני� ומסיי� פעולה של כל ,  מאפשר התחלה נקייהשיח� דואיפוס ה

 ל ידיע,  יש לאשר פעולה זושיח�דושל ה) ולמחוק את תוכנ( לנקות כדי. שרצו עד נקודת זמ� זו

 עתידיות ואז ברירת המחדל  איפוסנית� למנוע הופעת חלו� זה בפעולות. Yes על מקש לחיצה

בזמ� מחיקת . )20תמונה  ראו(אישור של המשתמש ב ללא צור�ימחק י שיח� דותוכ� ההיא ש

 ראו(עצמו שיח � הדו בחלו�  על ביצוע האיפוסתופיע הודעה)  שניותהאורכת כמה( שיח�דוה

  .)21תמונה 

 

  

  20תמונה 
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  12תמונה 

  Save Interactions History:שיח#דו חלו� הה שלהיסטוריהשמירת  •

 ,תוכ�ההיא ג� מאפשרת עריכת .  בקוב" חיצונישיח�דואופציה זו מאפשרת לשמור את תוכ� ה

א� מספר , שיח�דו פקודות 500�חלו� ההיסטוריה מוגבל ל. שמירהה לפני ביצוע ,בחלו� נפרד

  .)22תמונה  (שינוינית� לזה 

 א והי)כפי שיוסבר בהמש�(שלב מאוחר יותר השמירה מאפשרת טעינה של קוב" ההיסטוריה ב

לאחר שקוב" ההיסטוריה .  פעולות שחוזרות על עצמ�לביצוע סדרות של מתאימהבדר� כלל 

  .נטע� אפשר להריצו

  .לפני שמירתועריכת קוב" ב מראה כיצד נית� לבחור 22תמונה 
  

  

  22תמונה              

 כמו למשל ,)23תמונה  (יפתח לנו חלו� עריכה בו נוכל לבצע שינויי� או תוספותי, Yes נענה א�

כדי להקל על שימוש , שיח� בעזרת תוספות כאלו אפשר לתעד את הדו. ת שאני הכנסתיוהתוספ

  .עתידי בו

  

  32תמונה        
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יח שתאפשר שמירת ש�יפתח תיבת דות) איננו רוצי� לערו� את הקוב", כלומר( Noנענה א� 

שמירה זו מאפשרת הפעלה והרצה , כאמור). hist.סיומת ע� (שיח �של הדו ההיסטוריהקוב" 

�  .עתידית לפי הצור
  

 Load Interactions History as a Script :שיח#של דו ה היסטוריטעינת •

 אל תו�) hist. ע� סיומת ,להזכירכ�(טעינת ההיסטוריה מאפשרת קריאת תוכ� קוב" שנשמר 

 בבת  טעינה של כל פקודות הקוב"זו אינה ,כלומר (פקודה פקודה אחת  והפעלתושיח�דוחלו� ה

� וNext כפתורי ל ידיע) אחתPrevious) כפתור  .)24 תמונה ראוExecuteמבצע את השורה .  

  

  42תמונה 

  

  …Execute Interactions History:שיח#של דו ההרצת היסטורי •

  שלתוכנו,  כלומר.ב" היסטוריה שנשמר קוד� לכ� והרצתו פתיחת קותמאפשרפעולה זאת 

 .שיח�לצור� אתחול דופעולה זו מתאימה . שיח�דוהקוב" הופ� להיות פעיל בחלו� ה

  Lift current Interactions to Definitions:שיח#הדוהעתקת תוכ�  ♦

�מאפשרת לנו לנסות הוראות בה ,שימושית מאדאופציה Javaדו בחלו� ה�ו� ובסי, שיח

 לחלו� העריכה כחלק מקוד המקור של שיח�דו להעביר את הקוד מחלו� ה והבדיקהההתנסות

  .כניתוהת

   שיח-דו הראשית בחלון הפעולה הרצת ה5.6.2

  .שיח�דוהבתו� חלו� ) Main( הראשית פעולה בהרצת הDrJava כת סביבתתומ, לנוחות המשתמש

שיח על ידי כתיבת �בחלו� הדו GetNumber את התוכנית אנו מריצי� 25בתמונה   המוצגתבדוגמה

  :)שיח�דו לב שמשפט הקלט מופיע בחלו� המושי ( ואז ש� התוכניתJavaהמילה 
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  52תמונה 

 קלטהזנת . 5.7

 מחלקת באמצעות, DrJavaבסביבת צורת העבודה ע� קלט את ,  לנו הלומדי�פרק זה יבהיר

קוב" ההגדרות יש לוודא ש. "חשביסודות מדעי המ "המשמשת אותנו במהל� לימוד, Inהקלט 

  . תצורת סביבת העבודה,7.2 בסעי� כפי שמוסבר ,למחלקת הקלט הנדרשתכיל התייחסות מ

חלו� הקלט ,  בחלו� נפרדתמתבצע,  הקלט הזנתפעולת DrJavaבסביבת , כפי שצוי� קוד� לכ�

   .Standard Input ,סטנדרטיה

 לקליטת ,readDouble ,ר של�לקליטת מספ, readIntפעולות הקלט בה� נשתמש ה� 

�ו, לקליטת תו בודד, readChar, מספר ממשיreadString ,לקליטת מחרוזת.  

  : בשתי צורותהאלו פעולותנית� להפעיל את ה

הוראות אלה יפעילו את . המשתמשות בפעולות הקלטהוראות שיח � בחלו� הדולכתוב  אפשר .1

  .)26 תמונה ראו( DrJavaחלו� הקלט הסטנדרטי של 
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  62תמונה 

 Type in a, במקרה זה(והבקשה לביצוע , את הקלט עצמו יש להקליד בחלו� הקלט הסטנדרטי

character (דותופיע בחלו� ה�להקיש יש  ,תו בודדבמקרה זה , קלט מתאי�לאחר הקלדת . שיח

�על מקש הEnter כפתור ה או עלDoneהאת .  בחלו� הקלט � שבוצע נית� שיח�דוכל תהלי

�לו� הג� בחלראות  Consoleלתצוגה ,בצורה כוללת �דובחלו� ה בנוס� ).שראינו לעיל (שיח

� בחלו� ההנחיית הקלט והקלט עצמו את נית� לראות 27תמונה בConsole.  

  

  72תמונה 

בנקודת הזמ� בו הקלדנו נתוני� ) הפתוח (פעיל בתחתית החלו� מופיע ש� הקוב" ה:♥♥♥♥שימו 

  .כרח קשור לפעולה העכשווית שמתבצעתאינו בהקוב" זה א� , שיח� דובחלו� ה

  

2.  �� בתוכנית מלאהנית� כמוב� לשלב פעולות קלט בתוJava. הקלט שיתבצע יהיה זהה � תהלי

פרט לעובדה שהתהלי� מתבצע כתוצאה מהרצת תוכנית ולא מהקלדת , לתהלי� שתואר לעיל

  .שיח�דוהוראות קוד בחלו� ה

 הקלט של מספר של� תפעול המשתמשת ב,GetNumber ,כנית פשוטהו תזאת על ידי נדגי�

(readInt) מספר של� ולהדפיס את הקלט הנקלט מהמשתמש שמטרתה לקלוט:  
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תמונה .  נית� לראות את השלב בהרצת התוכנית בו נפתח חלו� הקלט הסטנדרטי28בתמונה מספר 

  . אליה� נתייחס מיד, זו מדגימה ג� כמה דברי� נוספי�

  

  82תמונה 

)A( כנית של ומראה את חלו� העריכה וקוד הת.GetNumber.java 

/** This application ("GetNumber") reads in an Integer saved   

 * in a variable input_num and  prints out the number typed in by 

 * the user 

 */ 

 

class GetNumber  

{ 

    public static void main (String args[])   

    { 

// Read in an Integer number    

      int input_num = In.readInt ("type in an Integer Number"); 

 

// Print the number typed by the user         

      System.out.println (input_num); 

    } 

} 

B  

A 

D 

C  

E  
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)B(  מראה את חלו� הקלט הסטנדרטי שלDrJavaכנית ו שמופיע ע� הרצת התGetNumber. 

)C( המילהכתיבת ,  האחת:כניתושתי צורות להרי" את הת Javaתוכניתש� האחריה  ו)  במקרה

 שמשמעותה הרצת 2Fמקש לחיצה על , ההאפשרות השניי. שיח�דובחלו� ה) GetNumberזה 

 .הרצת התוכנית המלאה, כלומר, )Main( ראשית ההפעולה

)D( שגוי �כנית מצפה לקלט של ו כאשר התAהאות הקלדת , למשל. הודעת שגיאה על הקלדת ער

 . וג� בחלו� הקונסולשיח�דוההודעה מופיעה בחלו� ה. מספר של�

)E( דולו� הודעה זו מוצגת בחה. הזי� לקלט שעל המשתמש להנחיההודעת ה�להבדיל , שיח

נית� לראות הקלדות אלה ג� בחלו� . מהקלט עצמו שמתבצע בחלו� הקלט הסטנדרטי

 .הקונסול

  ,נוספותה פעולותבנוכל לכתוב תוכניות דומות שעושות שימוש ,  להשלי� את התמונהכדי

readDouble, יממש לקריאת מספר ,readChar, ולקריאת תו בודד �readString, 

תו בודד או רצ� , מספר ממשי(בכל מקרה נצטר� להזי� קלט מתאי�  . של תווי�רצ�לקריאת 

מחלקת הקלט ,  בשלב זה.Done או על הכפתור Enterולסיי� בהקשה על מקש , )בהתאמה, תווי�

  .אינה תומכת בקלט בעברית

  התמצאות ואפשרויות חיפוש . 5.8

ת לחיפוש ומציאת ו שימושיכי�מייצגות דרה� . DrJava חיפוש בסביבת אפשרויות כמהישנ� 

 במידת ,כולל החלפתו בטקסט אחר, ) קדימה ואחורה,בשני הכיווני�(טקסט מסוי� בקוב" 

�  . הצור

  : ומאפשרות את החיפושי� כדלהל�Editתפריט הות תחת מוצעהאפשרויות הללו 

 Ctrl-F מקש קיצור –) …Find/Replace(מצא והחל�  •

  F3ור  מקש קיצ–) Find Next(חפש את הבא  •

  Shift+F3 מקש קיצור –) Find Previous(חפש את הקוד�  •

  Ctrl+G מקש קיצור –) …Go to Line... (גש לשורה •

לצד הלשוניות , Find/Replace תוסי� לשונית נוספת בש� הללובחירה של כל אחת מהאפשרויות 

�  :)29 תמונה ראו( הקיימות בתחתית העור
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  29תמונה 

הטקסט בדוגמה לעיל  (Find Nextכותרת שצמוד ל מלב� במבוקש להקיש את הטקסט הישכעת 

 להקליד את הטקסט יש,  טקסט זה בטקסט אחר בתוכנית להחלי�כדי. )Systemהמבוקש הוא 

,  ואז,צד ימי�בלבחור אחת מארבע האפשרויות , Replace Withכותרת הצמוד ל במלב�להחלפה 

  ).  לביצוע החלפת הטקסטReplace ,למשל(להקיש על אחד הכפתורי� בתחתית הלשונית 

  : אנו נזכיר את השתיי� העיקריות מביניה�. האפשרויות בצד ימי� מנחות את החיפוש

באותיות  (SYSTEM א� בתוכנית מופיעה המילה –) Match Case( ג� בגודל אותהתאמה 

אל החיפוש לא יביא אותנו , )באותיות קטנות ( systemואנו נבקש לחפש את הטקסט) גדולות

�אלא א� אפשרות ה, )sYStem או Systemוג� לא למופעי� כמו  (SYSTEMהמופע Match 

Caseהתאמת מילה שלמה.  כבויה Whole Word) (– ות התחומי� מיליתבצע חיפוש רק אחר 

  ).שאינ� תחומי� ברווחי� משני הצדדי� (י�להבדיל מקטעי מיל, �ברווחי� משני צידיה

 Find הכותרת שלצד נקליד את הטקסט לחיפוש במסגרת ,וי�ברצוננו רק למצוא טקסט מסא� 

Next ,נלח"ואח � המופע הבא חיפושל Find Next : על הכפתור המתאי� על פי כיוו� התנועהר כ

�ו) סו� הקוב"כיוו� ל, קדימהבכיוו�  (של הטקסטFind Previous ,כלומר(וד� המופע הקחיפוש ל ,

  ).תחילת הקוב"כיוו� ל, האחור
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 ת מתקדמותפונקציו .6

 )Debug Mode( שגיאות ריצה  ניפוי6.1

איתור . כניתו תה שלר שגיאות בזמ� ריצותי כלי� מתקדמי� לאתמספק DrJava סביבת 

. כניתובכפו� להגדרות שהגדרנו טר� הרצת הת, שיח� דושיח בחלו� ה�י דו"השגיאות מתבצע ע

  .Debug Mode ,דה מיוחדכנית באופ� עבוויש להרי" את הת, (debugging)לניפוי השגיאות 

ולהרי" , כניתו בקוד הת(break points)נית� להגדיר נקודות עצירה ? מה מאפשרת צורת הרצה זו

, היא מושהה, כנית מגיעה לנקודת עצירהוהתהרצת כאשר . את התוכנית עד לנקודת עצירה

להמשי� כנית ו המשתמש יכול לאפשר לת. בנקודה זוהמשתמש יכול לבחו� את ערכי המשתני�ו

 התקדמות בקצב של ,כלומר, ה מבוקרתיצאת ריצתה עד נקודת העצירה הבאה או להמשי� בר

  . כל פע�בשורה 

� בתפריט  הDebug Mode הבאופצייש לבחור ? Debugger#כיצד נשתמש בDebugger . ייפתח

� מסומ� בקו אדואת החלו� ה 30תמונה ב ראו(, שיח�הדו בי� חלו� העריכה לחלו� ,חלו� נוס�

�ובנוס� תתאפשר גישה לאופציות נוספות בתפריט ה, )מקווקו Debugger�  .  שיפורטו בהמש

 . ג� בתצורת עבודה זוותשאר הלשוניות של החלונות שהכרנו עד כה זמינ

 

  

  

  

  

  

  

  

  

  

  

  

  

  

  30תמונה 
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תהיה לה� כל  לא  Debugבתצורת כנית תו� כדי ריצה ושינויי� בקוד התא� נבצע  :♥♥♥♥שימו 

כנית מחדש ולהדר את הת, קוב" התוכניתאלה יש לשמור את כלבחו� שינויי�  כדי .השפעה

, תריע באמצעות הודעת אזהרהת DrJavaסביבת , במקרה כזה. Debug בתצורת ובולהריצה ש

  .30כפי שנית� לראות בתמונה 

 ולפיכ� ג�מספור השורות ב משו� שה� גורמי� לשינוישינויי� כאלה בזמ� ריצה אינ� מומלצי� 

 של חוסר  כזה מצב.המבוצעותלשורות מופיעות בחלו� העריכה שורות ההלחוסר תאימות בי� 

  . Current Document is out of sync with its class file: התאימות מלווה בהודעה

  : (Breakpoints) נקודות עצירה

� בחרנו באופציית הש לאחרDebug Mode בכל שורת  כמעט,יש ביכולתנו להגדיר נקודות עצירה 

 אפשרות .Toggle Breakpoint in Current Line האופציב בחירת ל ידי ע,קוד בחלו� העריכה

עכבר ובחירת האופציה  הימני של ה שימוש במקשל ידיהעריכה ענוספת היא לבצע זאת בחלו� 

Toggle Breakpoint.לרשימת וצבע בצבע אדו� ותתיהיא ת,  כאשר נגדיר שורת עצירה �וס

� בלשונית ההעצירה שמופיענקודות הBreakpointsבחלו� ה �Debugger,מתחת לחלו� העריכה   

  .)31 תמונה ראו(

  

  

  

  

  

  

  31תמונה 

  . GetNumber במחלקה 11� ו9רור נקודות עצירה בשורות ינית� לראות בב, בדוגמה לעיל

בע  בצבה נמצאת נקודת העצירה צבועההשורה ,  לנקודת עצירההרצת התוכנית מגיעהכאשר 

�דובחלו� ה) Prompt(ופיע סמ� מלאחר מכ� . שיח� הדו הודעה מתאימה בחלו� מוצגתכחול בהיר ו

  .ע� התוכנית בנקודה זו" שיח�דו" שיאפשר לנו שיח

אי� טע� להגדיר נקודת , למשל.  שיש בה הוראת ביצועבשורהנקודת עצירה  רדייש להג :♥♥♥♥שימו 

אי� להגדיר נקודת , בפרט. פותח מסולסל/סוגראו , ל משתנהערה צהעצירה בשורה שיש בה רק ה

למרות שה� , לא תעצור בנקודות אלהתוכנית בזמ� ריצה . עצירה בשורה ריקה או בשורת הערה

  " .כשרות"נקודות עצירה , לכאורה, נצבעות באדו� ונראות

 במצב  נמצאתהתוכניתבנקודה זו .  בהגעה לנקודת עצירה DrJavaתצורת מראה את 32תמונה 

, נית� לבחו� ער� של משתנה. ערכי כל המשתני�נית� לבחו� את  ו(Suspension)השהייה של 

 שוב נדגיש.  ע� הער� החדש של המשתנה(Resume)כנית ולהשי� בו ער� חדש ולהמשי� את הת

   .ההשהיהכנית בזמ� ו אי� לשנות שורות קוד בתכי
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  :  נית� להמשי� בשני אופני� אליה הגענומנקודת העצירה

�   הרצהשחידו • Resume : פעולתResumeתפריט  ה �� נגישה דרDebugger  , בחירת האופציה

Resume Debugger או מקש קיצור F7) האופציה קיימת ). כפי שנית� לראות בתפריט עצמו

�ג� ככפתור בחלו� הDebugger . את ריצת התוכנית �, ע� ההשמות החדשות(הפעלתה תמשי

 .א� ישנה כזאת,  העצירה הבאהותעצור בנקודת) א� הגדרנו כאלו

שעבורה כמה פקודות , שורה אחר שורה, תקדמות בצעדי�ה :Stepping –התקדמות בצעדי�  •

  :מתאימות

♦ Step Into – שמופיעה בשורת הקוד בה עצרנופעולה לפקודה זו תיכנס  , �ג� א� הדבר כרו

  . של מחלקה אחרתפעולהבמעבר לקוב" אחר ב

♦ Step Over –  את שורת הקוד הנוכחית ותעבור לשורת הקוד הבאה מבלי פקודה זו תבצע

  . בשורת ההוראה עליה הפעלנו את הפקודהפעולהלהיכנס ל

♦ Step Out –ליה נכנסנו ותעצור בשורת  הנוכחית אפעולה פקודה זו תסיי� את הרצתה של ה

  . הנוכחיתפעולההקוד הבאה לאחר השורה שהפעילה את ה

�ריט הפקודות אלה ניתנות להפעלה דר� תפDebugger , לחיצה על אחד הכפתורי�או על ידי 

�בחלו� הDebugger32 תמונה ראו(  שמתחת לחלו� העריכה(.  

 

  32תמונה 
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 )Preference Definitions( של סביבת העבודה תצורה 6.2

מס� ה .Editבתפריט  Preferences יהאופצב בחירהי "הגדרת סביבת העבודה מתבצעת ע

   .33 תמונהבמוצג המתקבל 

  33תמונה 

 כמהאנו נתייחס ל.  הינ� רבות ומגוונותDrJavaאפשרויות הגדרת תצורת סביבת העבודה של 

  .של התוכנה) Help(בקוב" העזרה נית� למצוא עזרי� נוספי� הנחיות ו .נקודות בלבד

Resource Location # �   :מיקו� המשאבי

מיקומו שגוי תהלי� שאו , ה אינו מוגדרקוב" זא� .  כחלק מההתקנהנקבע Tools.Jarקוב" המיקו� 

  ...).י לחיצה על הכפתור שעליו שלוש נקודות "החיפוש מתאפשר ע(יש להגדירו .  ההידור יכשל

Extra ClassPath: למשל. סביבת העבודהב הגדרה זו מאפשרת גישה לספריות נוספות לשימוש ,

ה אינה נמצאת יספריה א�ברור ש. :C בכונ� Yesodot תחת תיקיית הקלט מוגדרת ימיקומה של ספרי

  השייכות אליה פעולות לכתוב תוכניות שכוללות נוכל לא ,או שלא הוגדרה כלל, במקומה

Display Options # שליטה על תצוגה:  

 � ,Display Optionsהיכולת שלנו לשלוט על אלמנטי� שוני� בתצוגת סביבת העבודה מתאפשרת דר

   .34. תמונה מסב כפי שנית� לראות

  



 

 המחשבמדעי   - 33 -  אביב-אוניברסיטת תל, הוראת המדעים

  34תמונה 

  

  : בעלות משמעות תצוגהשלוש אפשרויותנדגיש 

  ארבע אפשרויות לבחירה, מראה סביבת העבודה – Look and Feel  .א

• Classic Metal   –תצורה מתכתית  

• Windows Classic –ת גרסת חלונות קלאסי 

• Windows –תצורת חלונות רגילה  

• Motif  – תצורת Motif) יוניקס( 

  ארבע אפשרויות לבחירה,  כלי� סרגל– Toolbar Buttons  .ב

• None –ללא סרגל כלי�  

• Text Only –טקסט בלבד בכפתורי סרגל הכלי�  

• Icons Only –צלמיות בלבד בכפתורי סרגל הכלי�  

• Text and Icons –טקסט וצלמיות בכפתורי סרגל הכלי�  

מומל" לעבוד .  הראה או הסתר את מספר השורות בעור�– Show All Line Number  .ג

 .לפחות בשלבי העבודה הראשוני�,  אופציה זו מופעלתרכאש

ה� תרומה ל ויש  להגדיר את תצורת סביבת העבודהשדרכ� נית�ישנ� שתי אפשרויות נוספות 

הגדרת צבעי טקסט ו )Fonts ( הגדרת הגופני� השוני�:כניתוהתובהירות מבחינת קריאות 

36� ו35ונות  תמורא ()Colors ('משתני� וכו, הודעות השגיאה, העריכה(.  



 

 המחשבמדעי   - 34 -  אביב-אוניברסיטת תל, הוראת המדעים

  :הגדרת צבעי עריכה

  35תמונה 

  :גופני�הגדרת 

  36תמונה 

Key Bindings –�   מיפוי מקשי

 משמש להידור הקבצי� F5המקש , למשל.  מראה כמה אפשרויות מתו� המגוו� הקיי�37תמונה 

�ו, הפתוחי�Shift F5המקשי� .  משמש להידור קוב" נוכחיCtrl Xו �Ctrl C משמשי� לפעולות 

מומל" . ומאפשרת מיפוי מקשי� בצורה מאד רחבה, הרשימה ארוכה. זירה והעתקה בהתאמהג

  .לעבור עליה� באופ� עצמאי
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  37תמונה 
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 נספחים

 דרישות המערכת 7.1

גרסה מתקדמת  או Virtual Machine Java 2 v 1.3 גרסת התקנה של ת דורשDrJavaסביבת 

  . יותר

� ה–הערה (JDKולא ה �JREהתקנת ה.  ))לציהיקומפ( לאפשר הידור כדית מותק�  חייב להיו�

JDKמכילה בתוכה התקנה של ה �JRE.  

מומל" להוריד את , )JVM )Java Virtual Machineהורדת גרסת פע� שמתעורר הצור� בבכל 

  .Windows עבור מערכת ההפעלה של Sun's JDK 1.4גרסת 

של ) דרייברי�(התקני� ות מותקני� חייבי� להי, DrJava לאפשר עבודה תקינה של כדי, בנוס�

TCP/IP.  

  .MB264 – התקנהפנוי הנדרש להדיסק השטח 

 התקנת סביבת העבודה 7.2

שאותו נית� להוריד מאתר קבוצת מדעי , את סביבת העבודה אפשר להתקי� מקוב" ההתקנה

לפי ההנחיות בד� , א"המחשב בחוג להוראת המדעי� של אוניברסיטת ת

http://www.tau.ac.il/~csedu/yesodot.html.  

את הקוב" ) Saveלבצע (לשמור , DJPackage.Zipכדי להפעיל את ההתקנה יש להוריד את הקוב" 

  :ואז, בתיקיה כלשהי בכונ� במחשב שלכ�

  

  :אלה השלבי� המתבצעי� בפעולת ההתקנה

  .:C\ תחת כונ� Yesodotיצירת תיקיה בש�  .1

  .לתיקיה שנוצרה) DrJava.Exe(העתקת קוב" ההפעלה של סביבת העבודה  .2

  .- C:\Yesodotלתיקיית יסודות ) In.Jar(העתקת קוב" ספריית הקלט  .3

לקוב" אי� ש� אלא סיומת , שימו לב (DrJavaהעתקת קוב" ההגדרות של סביבת העבודה של  .4

.drjava (לתיקיית המשתמש הרשו� ) בלבדLogged In( לתיקיית מתחת Documents and 

Settingsבכונ�  \C:.  

  תיקיית הכונ�ל Extract הקוב� ובצעו פעולת  אתופתח  )א(

 SetUpDJ.Exe  קוב� על ע� העכבר לחיצה כפולהלחצו  )ב(

 .�DOS נית� להפעיל את תכנית ההתקנה ג� בפתיחת חלו: הערה
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  :Avi עבור משתמש בש�  )38תמונה  ( של מבנה התיקייההנה דוגמה

  38תמונה 

  

� " צלמית הפעלה"יצירת  .5  Menu Entry עבור הפעלתDrJava . הכניסה בתפריט נקראת

"Java Environment"קישור להפעלה �39 י שנית� לראות בתמונהכפ,  ותחת תיקייה זו נוס:  

   

  

  39תמונה 

� כנת ההתקנה של הו תתהפעל .6 JDK, קוב"ה על  כפולהלחיצה ל ידיע, שהועתקה בשלב קוד�:  

jdk-1_5_0_07-windows-i586p   

  :תתקבל סדרת המסכי� הבאה
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I.  רישיו� �� להמשי� יש לבחור בכדי. )40תמונה ( License –מס "I accept the terms…" .

 .להתחלת ההתקנה Nextכפתור הל  עצולח

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  40תמונה 

II. התקנת ה�JDKאת הההתקנה ג� מתקינה. )41תמונה  ( עצמו �JRE) Java Runtime 

Environment( כפתור ה על צולח.  המוצעמומל" לא לשנות את מיקו� ההתקנהNext  כדי

� .להמשי

  

  14תמונה 



 

 המחשבמדעי   - 39 -  אביב-אוניברסיטת תל, הוראת המדעים

III. סבלנות. )42תמונה  ('שינוי הגדרות וכו, העתקת קבצי� – התקנה בפועל �התהלי� ! צרי

� ע� סיו� ההתקנה של הקיידל Nextכפתור ה. לוקח מספר דקותJDK. 

  

  24תמונה 

IV. הפעלת התקנת ה�JREהתקנת ה �� מתוJDK ) ישנ� שני מסכי: שימו לב. )43תמונה 

�להמש Nextכפתור ה על צו לח.� תיקיית ההתקנהומל" לא לשנות את שמ .התקנה.  

  

  34תמונה 



 

 המחשבמדעי   - 40 -  אביב-אוניברסיטת תל, הוראת המדעים

 

V. התקנת ה�JRE) סביבת ה�Java Runtime()  44תמונה.( 

 

  44תמונה 

  

VI.  "בכל מקרה אי� . מומל" להשאיר את שתי הבחירות ).45תמונה (בחירת הדפדפ� המומל

�להסיר את דפדפ� הExplorer .ר כפתוה על צולחNext כדי� . להמשי

  

  54תמונה 
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VII. ההתקנה בפועל של סביבת ה ��תהליJava Runtime ) מועתקי� ובמהלכ) 46תמונה 

 . הקבצי� הנדרשי� ומבוצעות ההגדרות הנדרשות

  

  64תמונה 

VIII.  כפתור ה על צו לח)47תמונה (סיו� ההתקנהFinishו� לסי. 

  

  74תמונה 
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 ? לאחר ההתקנהמה חשוב לוודא 7.3

 בטבלה פורטלפי המ(ות מתאימהת � הנדרשי� נמצאי� בתיקיויש לוודא שכל הקבצי ,ראשית

. קבצי ספרייה וקבצי הגדרות, חלק מהקבצי� ה� קבצי הפעלה.  לוודא עבודה תקינהכדי ,)למטה

כיבי סביבת העבודה בהקשר של יסודות מדעי המחשב ובכלל יתפקדו  שכל רכדי קיומ� ווודא

  :כשורה

 שם תיקייה  מאפייני הקובץ שם קובץ

DrJava.Exe    קוב" הפעלה ראשי של תוכנת

DrJava 

C:\Yesodot 

    

In.Jar קוב" מחלקת הקלט  C:\Yesodot 

     

.DrJava כנת וקוב" הגדרות של תDrJava המשתמש הרשו�תתיקיי  

    

Jdk-1_5_0_07-Windows-

i586-p.Exe 

 JDKקוב" התקנה של גרסת 

קוב" זה משמש כגיבוי . עדכנית

  .להתקנה נוספת

C:\Yesodot 

    

  .)48 תמונה ראו( Edit → Preferences תפריטדר� ה,  מותק� Tools.Jar כי הקוב" יש לוודא

  .)48 תמונה ראו( Edit → Preferences תפריטדר� ה,  מותק� In.Jarיש לוודא כי הקוב" 

  

  84תמונה 
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 שגיאות התקנה 7.4

     תופיע ע� הפעלת DrJava שלא תאפשר עבודה תקינה בסביבת ,השגיאה המהותית ביותר

DrJava , �  :)49תמונה (כ

  

  

  94תמונה          

�וה חלק מהתקנת השמהו Tools.Jar העדרו של קוב" הספרייישגיאה זו מציינת את הJDK .

 תשאיר את סביבת Noכפתור הלחיצה על . מוסבר היכ� צרי� למוצאו וניתנת האפשרות לבצע זאת

  .העבודה במצב לא תקי�

 )50תמונה ( Tools.Jarקוב" הנמצא את , בהנחה שלא שינינו את מיקו� תיקיית ההתקנה

  .C:\Program Files\Java\jdk1.5.0_07\lib בתיקייה

  

  50תמונה                       
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 את נפעיל כאשר תופיע) 51תמונה (שגיאה זו הודעה על : Executor Error – הפעלה תשגיא

DrJavaותוכנת ה �JDKמסיבה כלשהי)או אינה מותקנת כראוי ( אינה מותקנת . 

  

  15תמונה            

�כנת הו את תינוהתק: פתרו� הבעיהJDK קוב"ה כפולה על לחיצהי "ע   

jdk-1_5_0_07-windows-i586p.Exe  בתיקיית יסודות בכונ�C:\Yesodot.  

 תפעולשגיאות  7.5

למרות שהתוכנה מצפה שהוא יהיה , עדר קוב" בכונ� מסוי�י נובעות בדר� כלל מהושגיאות אל

   .)Fileריט תחת תפ(רשימת הקבצי� שנפתחו לאחרונה  אנו רואי� את 50בתמונה , למשל. ש�

 

  51תמונה                    

תמונה ב הודעת השגיאה ראו את ( בניסיו� פתיחה של הקוב" אינו נמצאGetNumber.Javaקוב" ה

אותה בעיה .  אינו מחובר כעת:Dהסיבה לכ� הוא שכונ� .  למרות שהוא מופיע ברשימה לעיל)52

  .הייתה צצה לו מחקנו את הקוב"
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  52ה תמונ            

 שגיאות הידור 7.6

  ). Syntax (תחבירשגיאות ההידור הנפוצות ביותר נוגעות לשגיאות 

כאל שמו  Innש� המהדר יתייחס ל. Innבקוד עצמו כתבנו א�  In הוא ת הקלט ש� מחלק ,למשל

  משתנה לא מוכר  של

  

  

  

 בקוד עצמו ש�. readIntעולה בש�  מוגדרת פבה  וIn הוא ת הקלטמחלק ש� :הנה דוגמה נוספת

 מחלקהבלא מוכרת  כפעולה יודיע כי זוהמהדר במקרה זה . ReadInt גדולה Rהפעולה נרשמה ע� 

In.  

  

  

  

� וwidthאנו משתמשי� בשני משתני� : והנה דוגמה אחרונהheight .שכחנו ל � על הצהירא

י�  בכל מקו� בו אנו משתמשי� במשתנ, שגיאות הידורארבע� קיבלנו וצאה מכתהמשתני� וכ

  .אלה
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נית� .  על מהות הבעיה ומיקומה למדי אינדיקציה ברורההודעת השגיאה נותנת, בכל המקרי�

י� שמופיעי� על ידי שימוש בחיצי� שעל לוח המקשי� או על ידי החיצ (לעבור משגיאה לשגיאה

 באפשרותנו .בחלו� פלט המהדר וג� בחלו� העריכהושורת הקוד השגויה תסומ� ג�  )53בתמונה 

 Highlight sourceאת האפשרות סימו� � על ידי אילהוריד את סימו� שורת השגיאה בקוד עצמו

  .)53תמונה (

  

  53תמונה                  

 רישיון הפעלת התוכנה 7.7

כל המשתמש בתוכנה ובמדרי� זה במסגרת . DrJavaשמית לגבי שימוש בתוכנת ההגדרה הרהנה 

  :לימודי יסודות מדעי המחשב  מתחייב לשמור על הכללי� הבאי�

DrJava Open Source License  

Developed by:   Java Programming Languages Team, Rice University 

                http://www.cs.rice.edu/~javaplt/  

Permission is hereby granted, free of charge, to any person obtaining a copy of this 

software and associated documentation files (the "Software"), to deal with the 

Copyright (C) 2001-2005 JavaPLT group at Rice University (javaplt@rice.edu) 

All rights reserved. 
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Software without restriction, including without limitation the rights to use, copy, 

modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and 

to permit persons to whom the Software is furnished to do so, subject to the following 

conditions:  

• Redistributions of source code must retain the above copyright notice, this list 

of conditions and the following disclaimers.  

• Redistributions in binary form must reproduce the above copyright notice, this 

list of conditions and the following disclaimers in the documentation and/or 

other materials provided with the distribution.  

• Neither the names of DrJava, the JavaPLT, Rice University, nor the names of 

its contributors may be used to endorse or promote products derived from this 

Software without specific prior written permission.  

• Products derived from this software may not be called "DrJava" nor use the 

term "DrJava" as part of their names without prior written permission from the 

JavaPLT group. For permission, write to javaplt@rice.edu.  


